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1. You can start Excel using the Start button on the Windows taskbar or a shortcut on your desktop.
  a. True
  b. False

ANSWER: True

POINTS: 1

REFERENCES: SCEX 1-5

QUESTION TYPE: True / False

HAS VARIABLES: False

LEARNING OBJECTIVES: 2.9.1 - Save a presentation.

CORPORATE STANDARDS: 4307 - Start Excel.

TOPICS: Shelly Cashman Series: Staring and Using Excel

KEYWORDS: Bloom's: Understand

DATE CREATED: 7/30/2019 1:34 AM

DATE MODIFIED: 7/30/2019 1:36 AM

2. You can use the DELETE key to clear cell contents.
  a. True
  b. False

ANSWER: True

POINTS: 1

REFERENCES: SCEX 1-59

QUESTION TYPE: True / False

HAS VARIABLES: False

LEARNING OBJECTIVES: 3.1.3 - Copy, cut, and paste data.

CORPORATE STANDARDS: 1171 - Clear cell contents.

TOPICS: Shelly Cashman Series: Correcting Errors

KEYWORDS: Bloom's: Understand

DATE CREATED: 7/30/2019 1:37 AM

DATE MODIFIED: 7/30/2019 1:39 AM

3. To print worksheet contents across the length of a page, you can use portrait orientation.
  a. True
  b. False

ANSWER: False

POINTS: 1

REFERENCES: SCEX 1-53

QUESTION TYPE: True / False

HAS VARIABLES: False

LEARNING OBJECTIVES: 2.4.4 - Insert headers and footers.

CORPORATE STANDARDS: 919 - Change the page orientation.

TOPICS: Shelly Cashman Series: Printing a Worksheet

KEYWORDS: Bloom's: Remember

https://selldocx.com/products
/test-bank-shelly-cashman-series-microsoft-office-365-and-excel-2019-comprehensive-1e-freund

https://selldocx.com/products/test-bank-shelly-cashman-series-microsoft-office-365-and-excel-2019-comprehensive-1e-freund
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DATE CREATED: 7/30/2019 1:39 AM

DATE MODIFIED: 7/30/2019 1:40 AM

4. When you enter a value in a worksheet cell, it is automatically left-aligned.
  a. True
  b. False

ANSWER: False

POINTS: 1

REFERENCES: SCEX 1-53

QUESTION TYPE: True / False

HAS VARIABLES: False

LEARNING OBJECTIVES: 3.1.1 - Enter data into cells.

CORPORATE STANDARDS: 2061 - Enter a number.

TOPICS: Shelly Cashman Series: Selecting a Cell

KEYWORDS: Bloom's: Remember

DATE CREATED: 7/30/2019 1:41 AM

DATE MODIFIED: 7/30/2019 1:42 AM

5. You can use the I-beam pointer to copy cell contents into adjacent cells.
  a. True
  b. False

ANSWER: False

POINTS: 1

REFERENCES: SCEX 1-22

QUESTION TYPE: True / False

HAS VARIABLES: False

LEARNING OBJECTIVES: 3.1.3 - Copy, cut, and paste data.

CORPORATE STANDARDS: 1324 - Copy cell content.

TOPICS: Shelly Cashman Series: Using the Fill Handle to copy a Cell to Adjacent Cells

KEYWORDS: Bloom's: Remember

DATE CREATED: 7/30/2019 1:43 AM

DATE MODIFIED: 7/30/2019 1:45 AM

6. To print a worksheet, you begin by going to Backstage view.
  a. True
  b. False

ANSWER: True

POINTS: 1

REFERENCES: SCEX 1-55

QUESTION TYPE: True / False

HAS VARIABLES: False

LEARNING OBJECTIVES: 2.6.2 - Change presentation views.
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CORPORATE STANDARDS: 3191 - Print a worksheet.

TOPICS: Shelly Cashman Series: Printing the Worksheet

KEYWORDS: Bloom's: Remember

DATE CREATED: 7/30/2019 1:46 AM

DATE MODIFIED: 7/30/2019 1:48 AM

7. To fit all worksheet content on one page, you can set page scaling in Backstage view.
  a. True
  b. False

ANSWER: True

POINTS: 1

REFERENCES: SCEX 1-53

QUESTION TYPE: True / False

HAS VARIABLES: False

LEARNING OBJECTIVES: 2.6.3 - Navigate between slides in different views.

CORPORATE STANDARDS: 3671 - Scale a worksheet for printing.

TOPICS: Shelly Cashman Series: Printing the Worksheet

KEYWORDS: Bloom's: Apply

DATE CREATED: 7/30/2019 1:48 AM

DATE MODIFIED: 7/30/2019 1:50 AM

8. You can edit cell contents in the Formula bar or in the cell itself.
  a. True
  b. False

ANSWER: True

POINTS: 1

REFERENCES: SCEX 1-57

QUESTION TYPE: True / False

HAS VARIABLES: False

LEARNING OBJECTIVES: 3.1.2 - Replace data.

CORPORATE STANDARDS: 2004 - Edit cell contents.

TOPICS: Shelly Cashman Series: Correcting Errors

KEYWORDS: Bloom's: Understand

DATE CREATED: 7/30/2019 1:51 AM

DATE MODIFIED: 7/30/2019 1:52 AM

9. To enter a typed number into a cell, you can press Tab or Backspace.
ANSWER: False - Enter

False - enter
False - ENTER

POINTS: 1

REFERENCES: SCEX 1-53
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QUESTION TYPE: Modified True / False

HAS VARIABLES: False

STUDENT ENTRY MODE: Basic

LEARNING OBJECTIVES: 3.1.1 - Enter data into cells.

CORPORATE STANDARDS: 2061 - Enter a number.

TOPICS: Shelly Cashman Series: Selecting a Cell

KEYWORDS: Bloom's: Remember

DATE CREATED: 7/30/2019 1:53 AM

DATE MODIFIED: 7/30/2019 1:54 AM

10. When you copy and paste a formula with absolute cell references, Excel substitutes new references to reflect the new 
formula location.
ANSWER: False - relative

False - Relative
False - RELATIVE

POINTS: 1

REFERENCES: SCEX 1-22

QUESTION TYPE: Modified True / False

HAS VARIABLES: False

STUDENT ENTRY MODE: Basic

LEARNING OBJECTIVES: 3.1.3 - Copy, cut, and paste data.

CORPORATE STANDARDS: 1288 - Copy a formula.

TOPICS: Shelly Cashman Series: Using the Fill Handle to Copy a Cell to Adjacent Cells

KEYWORDS: Bloom's: Understand

DATE CREATED: 7/30/2019 1:57 AM

DATE MODIFIED: 7/30/2019 4:33 AM

11. To find the largest value in a cell range, use the MIN function.
ANSWER: False - Max

False - MAX
False - max

POINTS: 1

REFERENCES: SCEX 1-26

QUESTION TYPE: Modified True / False

HAS VARIABLES: False

STUDENT ENTRY MODE: Basic

LEARNING OBJECTIVES: 5.1.3 - Perform calculations using functions.

CORPORATE STANDARDS: 1459 - Create a formula using the MAX function.

TOPICS: Shelly Cashman Series: Calculating Average, Maximum, and Minimum Values

KEYWORDS: Bloom's: Remember

DATE CREATED: 7/30/2019 2:00 AM

DATE MODIFIED: 7/30/2019 2:02 AM
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12. The easiest way to insert the SUM function is to use the AutoSum button on the Home tab.
  a. True
  b. False

ANSWER: True

POINTS: 1

REFERENCES: SCEX 1-20

QUESTION TYPE: True / False

HAS VARIABLES: False

LEARNING OBJECTIVES: 5.1.3 - Perform calculations using functions.

CORPORATE STANDARDS: 1487 - Create a formula using the SUM function.

TOPICS: Shelly Cashman Series: Calculating Sums and Using Formulas

KEYWORDS: Bloom's: Remember

DATE CREATED: 7/30/2019 2:03 AM

DATE MODIFIED: 7/30/2019 2:05 AM

13. You have selected a cell with a formula. Which of the following can you use to copy that formula to an adjacent cell?
  a. mode indicator
  b. Page  Break Preview
  c. scroll bar
  d. Fill handle

ANSWER: d

POINTS: 1

REFERENCES: SCEX 1-27

QUESTION TYPE: Multiple Choice

HAS VARIABLES: False

LEARNING OBJECTIVES: 3.1.3 - Copy, cut, and paste data.

CORPORATE STANDARDS: 4543 - Use the Fill handle to copy a formula.

TOPICS: Shelly Cashman Series: Calculating Average, Maximum, and Minimum Values

KEYWORDS: Bloom's: Remember

DATE CREATED: 7/30/2019 2:05 AM

DATE MODIFIED: 7/30/2019 2:07 AM

14. In the formula =SUM(A6:A9), which of the following best describes A6?
  a. argument
  b. function
  c. label
  d. active cell

ANSWER: a

POINTS: 1

REFERENCES: SCEX 1-20

QUESTION TYPE: Multiple Choice

HAS VARIABLES: False
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LEARNING OBJECTIVES: 5.1.3 - Perform calculations using functions.

CORPORATE STANDARDS: 1487 - Create a formula using the SUM function.

TOPICS: Shelly Cashman Series: Calculating Sums and Using Formulas

KEYWORDS: Bloom's: Understand

DATE CREATED: 7/30/2019 2:08 AM

DATE MODIFIED: 7/30/2019 2:10 AM

15. Which of the following lets you edit the contents of a cell?
  a. Click the cell, click the status bar, and press Enter.
  b. Click the cell and click in the status bar.
  c. Double-click the cell, click in the status bar, or just start typing.
  d. Double-click the cell or click in the formula bar.

ANSWER: d

POINTS: 1

REFERENCES: SCEX 1-57

QUESTION TYPE: Multiple Choice

HAS VARIABLES: False

LEARNING OBJECTIVES: 3.1.2 - Replace data.

CORPORATE STANDARDS: 2004 - Edit cell contents.

TOPICS: Shelly Cashman Series: Correcting Errors

KEYWORDS: Bloom's: Remember

DATE CREATED: 7/30/2019 2:17 AM

DATE MODIFIED: 7/30/2019 2:42 AM

16. Where can you see a preview of how your worksheet will look when printed, including headers?
  a. Print tab in Backstage view
  b. Page Break preview
  c. Normal view
  d. File preview

ANSWER: a

POINTS: 1

REFERENCES: SCEX 1-52

QUESTION TYPE: Multiple Choice

HAS VARIABLES: False

LEARNING OBJECTIVES: 2.6.2 - Change presentation views.

CORPORATE STANDARDS: 3181 - Preview a worksheet for printing.

TOPICS: Shelly Cashman Series: Printing a Worksheet

KEYWORDS: Bloom's: Remember

DATE CREATED: 7/30/2019 2:25 AM

DATE MODIFIED: 7/30/2019 2:29 AM

17. Which of the following formulas totals the cells B6, B7, B8, B9, and B10 most efficiently?
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  a. The formula =B6+B7+B8+B9+B10.
  b. The formula =TOTAL(B6-B10)
  c. The formula =SUM(B6:B10)
  d. The formula +SUM(B6-B10)

ANSWER: c

POINTS: 1

REFERENCES: SCEX 1-26

QUESTION TYPE: Multiple Choice

HAS VARIABLES: False

LEARNING OBJECTIVES: 5.1.1 - Insert footnotes and endnotes.

CORPORATE STANDARDS: 2057 - Enter a formula that uses a function.

TOPICS: Shelly Cashman Series: Calculating Average, Maximum, and Minimum Values

KEYWORDS: Bloom's: Apply

DATE CREATED: 7/30/2019 2:30 AM

DATE MODIFIED: 7/30/2019 2:32 AM

18. To have Excel enter the lowest price from a range of prices, which of the following would you use?
  a. MAX function
  b. COUNT function
  c. MIN function
  d. COUNTA function

ANSWER: c

POINTS: 1

REFERENCES: SCEX 1-26

QUESTION TYPE: Multiple Choice

HAS VARIABLES: False

LEARNING OBJECTIVES: 5.1.3 - Perform calculations using functions.

CORPORATE STANDARDS: 1462 - Create a formula using the MIN function.

TOPICS: Shelly Cashman Series: Calculating Average, Maximum, and Minimum Values

KEYWORDS: Bloom's: Understand

DATE CREATED: 7/30/2019 2:32 AM

DATE MODIFIED: 7/30/2019 2:34 AM

19. Which of the following tabs lets you see exactly how your worksheet looks before printing?
  a. Insert
  b. View
  c. Formulas
  d. File

ANSWER: d

POINTS: 1

REFERENCES: SCEX 1-52

QUESTION TYPE: Multiple Choice
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HAS VARIABLES: False

LEARNING OBJECTIVES: 2.6.2 - Change presentation views.

CORPORATE STANDARDS: 3181 - Preview a worksheet for printing.

TOPICS: Shelly Cashman Series: Printing a Worksheet

KEYWORDS: Bloom's: Remember

DATE CREATED: 7/30/2019 2:35 AM

DATE MODIFIED: 7/30/2019 2:37 AM

20. To see a preview of how a pasted value will look, which of the following would you use?
  a. Fill button
  b. AutoFill Options button
  c. Paste button
  d. Paste List arrow

ANSWER: d

POINTS: 1

REFERENCES: SCEX 1-52

QUESTION TYPE: Multiple Choice

HAS VARIABLES: False

LEARNING OBJECTIVES: 2.6.2 - Change presentation views.

CORPORATE STANDARDS: 3181 - Preview a worksheet for printing.

TOPICS: Shelly Cashman Series: Printing a Worksheet

KEYWORDS: Bloom's: Remember

DATE CREATED: 7/30/2019 2:37 AM

DATE MODIFIED: 7/30/2019 2:40 AM

21. Which of the following functions would you use to calculate the arithmetic mean of a price list?
  a. MAX
  b. COUNT
  c. SUM
  d. AVERAGE

ANSWER: d

POINTS: 1

REFERENCES: SCEX 1-26

QUESTION TYPE: Multiple Choice

HAS VARIABLES: False

LEARNING OBJECTIVES: 5.1.3 - Perform calculations using functions.

CORPORATE STANDARDS: 1419 - Create a formula using the AVERAGE function.

TOPICS: Shelly Cashman Series: Calculating Average, Maximum, and Minimum Values

KEYWORDS: Bloom's: Understand

DATE CREATED: 7/30/2019 2:42 AM

DATE MODIFIED: 7/30/2019 2:45 AM
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22. To print your worksheet on a piece of paper larger than 8-1/2 x 11", which Excel tab would you use?
  a. Home
  b. Page Layout
  c. Insert
  d. View

ANSWER: b

POINTS: 1

REFERENCES: SCEX 1-54

QUESTION TYPE: Multiple Choice

HAS VARIABLES: False

LEARNING OBJECTIVES: 2.4.4 - Insert headers and footers.

CORPORATE STANDARDS: 923 - Change the paper size.

TOPICS: Shelly Cashman Series: Printing a Worksheet

KEYWORDS: Bloom's: Remember

DATE CREATED: 7/30/2019 2:45 AM

DATE MODIFIED: 7/30/2019 2:47 AM

23. To print more than one copy of your worksheet, which tab would you go to?
  a. View
  b. Page Layout
  c. Insert
  d. File

ANSWER: d

POINTS: 1

REFERENCES: SCEX 1-54

QUESTION TYPE: Multiple Choice

HAS VARIABLES: False

LEARNING OBJECTIVES: 2.6.3 - Navigate between slides in different views.

CORPORATE STANDARDS: 904 - Change the number of copies to print.

TOPICS: Shelly Cashman Series: Printing a Worksheet

KEYWORDS: Bloom's: Remember

DATE CREATED: 7/30/2019 2:47 AM

DATE MODIFIED: 7/30/2019 2:50 AM

24. If you discover an error immediately after you have confirmed a cell entry, what of the following would you use next?
  a. The Undo button on the Quick Access toolbar
  b. The Cancel button on the Formula bar
  c. The Enter button on the Formula bar
  d. The Save button on the Quick Access toolbar

ANSWER: a

POINTS: 1

REFERENCES: SCEX 1-59
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QUESTION TYPE: Multiple Choice

HAS VARIABLES: False

LEARNING OBJECTIVES: 2.8.1 - Inspect a workbook for hidden properties and personal information.

CORPORATE STANDARDS: 4419 - Undo an action.

TOPICS: Shelly Cashman Series: Correcting Errors

KEYWORDS: Bloom's: Remember

DATE CREATED: 7/30/2019 2:51 AM

DATE MODIFIED: 7/30/2019 2:53 AM

25. To select a single worksheet cell so you can work with it, which of the following would you do?
  a. Click the cell.
  b. Move the cell pointer over the cell.
  c. Click the status bar.
  d. Click the Name box.

ANSWER: a

POINTS: 1

REFERENCES: SCEX 1-12

QUESTION TYPE: Multiple Choice

HAS VARIABLES: False

LEARNING OBJECTIVES: 2.2.2 - Create and modify custom themes.

CORPORATE STANDARDS: 3693 - Select a cell.

TOPICS: Shelly Cashman Series: Selecting a Cell

KEYWORDS: Bloom's: Remember

DATE CREATED: 7/30/2019 2:54 AM

DATE MODIFIED: 7/30/2019 2:56 AM

26. Which of the following functions inserts the total of a range?
  a. ROUND
  b. AUTOSUM
  c. AVERAGE
  d. SUM

ANSWER: d

POINTS: 1

REFERENCES: SCEX 1-20

QUESTION TYPE: Multiple Choice

HAS VARIABLES: False

LEARNING OBJECTIVES: 5.1.3 - Perform calculations using functions.

CORPORATE STANDARDS: 1487 - Create a formula using the SUM function.

TOPICS: Shelly Cashman Series: Calculating Sums and Using Formulas

KEYWORDS: Bloom's: Remember

DATE CREATED: 7/30/2019 2:57 AM

DATE MODIFIED: 7/30/2019 3:00 AM
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27. How many actions does the Undo button let you reverse?
  a. 24
  b. 50
  c. 75
  d. 100

ANSWER: d

POINTS: 1

REFERENCES: SCEX 1-59

QUESTION TYPE: Multiple Choice

HAS VARIABLES: False

LEARNING OBJECTIVES: 2.8.1 - Inspect a workbook for hidden properties and personal information.

CORPORATE STANDARDS: 4419 - Undo an action.

TOPICS: Shelly Cashman Series: Correcting Errors

KEYWORDS: Bloom's: Remember

DATE CREATED: 7/30/2019 3:01 AM

DATE MODIFIED: 7/30/2019 3:04 AM

28. Which of the following would you use to create a duplicate of the selected cell when the CTRL key is pressed?
  a. Normal pointer
  b. I-beam pointer
  c. Move pointer
  d. Copy pointer

ANSWER: d

POINTS: 1

REFERENCES: SCEX 1-23

QUESTION TYPE: Multiple Choice

HAS VARIABLES: False

LEARNING OBJECTIVES: 3.1.3 - Copy, cut, and paste data.

CORPORATE STANDARDS: 1324 - Copy cell content.

TOPICS: Shelly Cashman Series: Using the Fill Handle to Copy a Cell to Adjacent Cells

KEYWORDS: Bloom's: Remember

DATE CREATED: 7/30/2019 3:04 AM

DATE MODIFIED: 7/30/2019 3:06 AM

29. Which of the following lets you search for a function or select one from a category?
  a. Function Arguments dialog box
  b. clipboard
  c. formula bar
  d. Insert Function dialog box

ANSWER: d

POINTS: 1
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REFERENCES: SCEX 1-26

QUESTION TYPE: Multiple Choice

HAS VARIABLES: False

LEARNING OBJECTIVES: 5.1.1 - Insert footnotes and endnotes.

CORPORATE STANDARDS: 2057 - Enter a formula that uses a function.

TOPICS: Shelly Cashman Series: Calculating Average, Maximum, and Minimum Values

KEYWORDS: Bloom's: Remember

DATE CREATED: 7/30/2019 3:07 AM

DATE MODIFIED: 7/30/2019 3:09 AM

30. Your worksheet is too wide to fit on one portrait page. What is the best way to fix this problem?
  a. Hide the column headings.
  b. Insert a function.
  c. Copy columns to the next page.
  d. Change the page orientation to landscape.

ANSWER: d

POINTS: 1

REFERENCES: SCEX 1-53

QUESTION TYPE: Multiple Choice

HAS VARIABLES: False

LEARNING OBJECTIVES: 2.4.4 - Insert headers and footers.

CORPORATE STANDARDS: 919 - Change the page orientation.

TOPICS: Shelly Cashman Series: Printing a Worksheet

KEYWORDS: Bloom's: Apply

DATE CREATED: 7/30/2019 3:10 AM

DATE MODIFIED: 7/30/2019 3:12 AM

31. Which of the following tabs lets you set worksheet print options?
  a. File
  b. Home
  c. Page Layout
  d. View

ANSWER: a

POINTS: 1

QUESTION TYPE: Multiple Choice

HAS VARIABLES: False

LEARNING OBJECTIVES: 2.6.2 - Change presentation views.

CORPORATE STANDARDS: 3191 - Print a worksheet.

TOPICS: Shelly Cashman Series: Printing the Worksheet

KEYWORDS: Bloom's: Remember

DATE CREATED: 7/30/2019 3:13 AM

DATE MODIFIED: 7/30/2019 3:15 AM
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32. To print your worksheet at its actual size, which of the following would you select?
  a. Fit to
  b. No scaling
  c. Fit sheet to one page
  d. Scale to fit

ANSWER: b

POINTS: 1

REFERENCES: SCEX 1-53

QUESTION TYPE: Multiple Choice

HAS VARIABLES: False

LEARNING OBJECTIVES: 2.6.3 - Navigate between slides in different views.

CORPORATE STANDARDS: 3671 - Scale a worksheet for printing.

TOPICS: Shelly Cashman Series: Printing the Worksheet

KEYWORDS: Bloom's: Remember

DATE CREATED: 7/30/2019 3:15 AM

DATE MODIFIED: 7/30/2019 3:17 AM

33. Which of the following is the temporary Windows storage area that holds selections you copy or cut?
  a. Clipboard
  b. Backstage
  c. Name box
  d. Worksheet window

ANSWER: a

POINTS: 1

REFERENCES: SCEX 1-22

QUESTION TYPE: Multiple Choice

HAS VARIABLES: False

LEARNING OBJECTIVES: 3.1.3 - Copy, cut, and paste data.

CORPORATE STANDARDS: 1288 - Copy a formula.

TOPICS: Shelly Cashman Series: Using the Fill Handle to Copy a Cell to Adjacent Cells

KEYWORDS: Bloom's: Remember

DATE CREATED: 7/30/2019 3:18 AM

DATE MODIFIED: 7/30/2019 3:21 AM

34. Which of the following is a built-in formula that helps you perform complex calculations?
  a. clipboard
  b. mode indicator
  c. named range
  d. function

ANSWER: d

POINTS: 1
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REFERENCES: SCEX 1-26

QUESTION TYPE: Multiple Choice

HAS VARIABLES: False

LEARNING OBJECTIVES: 5.1.1 - Insert footnotes and endnotes.

CORPORATE STANDARDS: 2057 - Enter a formula that uses a function.

TOPICS: Shelly Cashman Series: Calculating Average, Maximum, and Minimum Values

KEYWORDS: Bloom's: Understand

DATE CREATED: 7/30/2019 3:21 AM

DATE MODIFIED: 7/30/2019 3:26 AM

35. When you cut or copy a cell, it is cut or copied to which of the following?
  a. Neither the Windows or Office Clipboard
  b. Both the Windows and Office Clipboard
  c. Only the Office Clipboard
  d. Only the Windows Clipboard

ANSWER: b

POINTS: 1

REFERENCES: SCEX 1-22

QUESTION TYPE: Multiple Choice

HAS VARIABLES: False

LEARNING OBJECTIVES: 3.1.3 - Copy, cut, and paste data.

CORPORATE STANDARDS: 1288 - Copy a formula.

TOPICS: Shelly Cashman Series: Using the Fill Handle to Copy a Cell to Adjacent Cells

KEYWORDS: Bloom's: Understand

DATE CREATED: 7/30/2019 3:27 AM

DATE MODIFIED: 7/30/2019 3:29 AM

36. Which of the following can you use to insert a formula using a function?
  a. Insert Function dialog box
  b. AutoSum button on the Ribbon
  c. AutoSum list arrow on the Ribbon
  d. Copy and paste a cell containing a function

ANSWER: a, b, c, d

POINTS: 1

REFERENCES: SCEX 1-26

QUESTION TYPE: Multiple Response

HAS VARIABLES: False

LEARNING OBJECTIVES: 5.1.1 - Insert footnotes and endnotes.

CORPORATE STANDARDS: 2057 - Enter a formula that uses a function.

TOPICS: Shelly Cashman Series: Calculating Average, Maximum, and Minimum Values

KEYWORDS: Bloom's: Understand

DATE CREATED: 7/30/2019 3:30 AM
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DATE MODIFIED: 7/30/2019 3:31 AM

37. To create a new, blank workbook, which of the following can you use?
  a. The Open command in Backstage view.
  b. The New command in Backstage view.
  c. The New command on the File tab.
  d. The Open command on the File tab.

ANSWER: b, c

POINTS: 1

REFERENCES: SCEX 1-5

QUESTION TYPE: Multiple Response

HAS VARIABLES: False

LEARNING OBJECTIVES: 2.1.1 - Create a blank desktop database.

CORPORATE STANDARDS: 1349 - Create a blank workbook.

TOPICS: Shelly Cashman Series: Starting and Using Excel

KEYWORDS: Bloom's: Remember

DATE CREATED: 7/30/2019 3:32 AM

DATE MODIFIED: 7/30/2019 3:35 AM

38. To insert an equation,  click on the Object in the Text group on the Insert tab, then click Microsoft Equation 3.0 in the 
Object type box, and then click OK.
  a. True
  b. False

ANSWER: True

POINTS: 1

REFERENCES: SCEX 1-12

QUESTION TYPE: True / False

HAS VARIABLES: False

LEARNING OBJECTIVES: 3.1.1 - Enter data into cells.

CORPORATE STANDARDS: 2684 - Insert an equation.

TOPICS: Shelly Cashman Series: Selecting a Cell

KEYWORDS: Bloom's: Remember

DATE CREATED: 7/30/2019 3:35 AM

DATE MODIFIED: 7/30/2019 3:37 AM

39. Which of the following will you select as X in the given series of clicks to insert a pie chart: Insert > Charts group > X 
>?
  a. Insert Column Chart
  b. Insert Combo Chart
  c. Insert Pie or Doughnut Chart
  d. Insert Stock, Surface or Radar Chart

ANSWER: c
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POINTS: 1

REFERENCES: SCEX 1-45

QUESTION TYPE: Multiple Choice

HAS VARIABLES: False

LEARNING OBJECTIVES: 6.1.1 - Insert a new chart.

CORPORATE STANDARDS: 2573 - Insert a Pie chart.

TOPICS: Shelly Cashman Series: Adding a Pie Chart to the Worksheet

KEYWORDS: Bloom's: REMEMBER

DATE CREATED: 7/30/2019 3:38 AM

DATE MODIFIED: 7/30/2019 3:41 AM

40. Which of the following will you select as X in the following series of clicks to change the chart style:  Chart > Chart 
Style > X > Any Chart Style?
  a. Style
  b. Color
  c. Border
  d. Shape

ANSWER: a

POINTS: 1

REFERENCES: SCEX 1-48

QUESTION TYPE: Multiple Choice

HAS VARIABLES: False

LEARNING OBJECTIVES: 6.2.4 - Apply styles to PivotTables and PivotCharts.

CORPORATE STANDARDS: 692 - Change a chart style.

TOPICS: Shelly Cashman Series: Adding a Pie Chart to the Worksheet

KEYWORDS: Bloom's: REMEMBER

DATE CREATED: 7/30/2019 3:42 AM

DATE MODIFIED: 7/30/2019 3:46 AM

41. Binay wants to create an X-Y scatter plot. To do so, he should select the data he wants to plot in the scatter chart, then 
click the Insert tab, and then click Insert Scatter (X, Y) or Bubble Chart.
  a. True
  b. False

ANSWER: True

POINTS: 1

REFERENCES: SCEX 1-45

QUESTION TYPE: True / False

HAS VARIABLES: False

LEARNING OBJECTIVES: 6.1.1 - Insert a new chart.

CORPORATE STANDARDS: 1628 - Create an X-Y scatter plot.

TOPICS: Shelly Cashman Series: Adding a Pie Chart to the Worksheet

KEYWORDS: Bloom's: UNDERSTAND
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DATE CREATED: 7/30/2019 3:50 AM

DATE MODIFIED: 7/30/2019 3:51 AM

42. On which tab and button are document properties located for editing?
  a. File tab, Info Button
  b. View tab, Show button
  c. Review tab, Changes button
  d. Home tab, Alignment button

ANSWER: a

POINTS: 1

REFERENCES: SCEX 1-52

QUESTION TYPE: Multiple Choice

HAS VARIABLES: False

LEARNING OBJECTIVES: 2.5.7 - Manage document properties.

CORPORATE STANDARDS: 2012 - Edit document properties.

TOPICS: Shelly Cashman Series: Document Properties

KEYWORDS: Bloom's: REMEMBER

DATE CREATED: 7/30/2019 3:52 AM

DATE MODIFIED: 7/30/2019 3:53 AM

43. Henri wants to convert a workbook  to PDF so that he can print it in high quality using a commercial printer. He can 
do so by clicking on Page Layout > Save As > (Enter name in ) File name box > Save As type list > PDF > Minimum Size 
(publishing online) > Options > OK > Save.
  a. True
  b. False

ANSWER: False

POINTS: 1

REFERENCES: SCEX 1-53

QUESTION TYPE: True / False

HAS VARIABLES: False

LEARNING OBJECTIVES: 2.7.1 - Save workbooks in alternative file formats.

CORPORATE STANDARDS: 2157 - Export a workbook to a PDF or XPS document.

TOPICS: Shelly Cashman Series: Printing a Worksheet

KEYWORDS: Bloom's: UNDERSTAND

DATE CREATED: 7/30/2019 3:53 AM

DATE MODIFIED: 7/30/2019 3:54 AM

44. To customize the status bar, right click on the status bar to open the Customize Status Bar menu and uncheck the items 
that you don't  want to show.
  a. True
  b. False

ANSWER: True



Name
:

   Class
:

   Dat
e:

 

Excel Module 01

Copyright Cengage Learning. Powered by Cognero. Page 18

POINTS: 1

REFERENCES: SCEX 1-8

QUESTION TYPE: True / False

HAS VARIABLES: False

LEARNING OBJECTIVES: 2.1.3 - Hide and lock database objects.

CORPORATE STANDARDS: 1662 - Customize the status bar.

TOPICS: Shelly Cashman Series: Starting and Using Excel

KEYWORDS: Bloom's: REMEMBER

DATE CREATED: 7/30/2019 3:55 AM

DATE MODIFIED: 7/30/2019 3:56 AM

45. The Comma Style format adds a comma and a dollar sign to a cell value.
  a. True
  b. False

ANSWER: False

POINTS: 1

REFERENCES: SCEX 1-41

QUESTION TYPE: True / False

HAS VARIABLES: False

LEARNING OBJECTIVES: 3.2.4 - Apply number formats.

CORPORATE STANDARDS: 559 - Apply the Comma number format.

TOPICS: Shelly Cashman Series: Formatting the Worksheet

KEYWORDS: Bloom's: Understand

DATE CREATED: 7/30/2019 3:56 AM

DATE MODIFIED: 7/30/2019 3:58 AM

46. A predesigned combination of formats, such as font size and color, is called a cell default.
ANSWER: False - style

False - STYLE
False - Style

POINTS: 1

REFERENCES: SCEX 1-32

QUESTION TYPE: Modified True / False

HAS VARIABLES: False

STUDENT ENTRY MODE: Basic

LEARNING OBJECTIVES: 3.2.7 - Copy, cut, and paste a table.

CORPORATE STANDARDS: 414 - Apply a cell style.

TOPICS: Shelly Cashman Series: Formatting the Worksheet

KEYWORDS: Bloom's: Remember

DATE CREATED: 7/30/2019 3:58 AM

DATE MODIFIED: 7/30/2019 4:01 AM
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47. To combine multiple cells into one and center its content, you change the cells' style.
ANSWER: False - alignment

False - Alignment
False - ALIGNMENT

POINTS: 1

REFERENCES: SCEX 1-38

QUESTION TYPE: Modified True / False

HAS VARIABLES: False

STUDENT ENTRY MODE: Basic

LEARNING OBJECTIVES: 3.2.1 - Check spelling.

CORPORATE STANDARDS: 2833 - Merge and center cell contents.

TOPICS: Shelly Cashman Series: Formatting the Worksheet

KEYWORDS: Bloom's: Remember

DATE CREATED: 7/30/2019 4:02 AM

DATE MODIFIED: 7/30/2019 4:04 AM

48. When you double-click a cell's right column border, which of the following occurs?
  a. The column is deleted.
  b. AutoFit resizes the column to 8.43 characters wide.
  c. A column is added to the right of the column's border.
  d. AutoFit resizes the column to the widest cell entry.

ANSWER: d

POINTS: 1

REFERENCES: SCEX 1-42

QUESTION TYPE: Multiple Choice

HAS VARIABLES: False

LEARNING OBJECTIVES: 2.4.7 - Format page numbers.

CORPORATE STANDARDS: 3391 - Resize a column using AutoFit.

TOPICS: Shelly Cashman Series: Formatting the Worksheet

KEYWORDS: Bloom's: Understand

DATE CREATED: 7/30/2019 4:06 AM

DATE MODIFIED: 7/30/2019 4:07 AM

49. To change the color of cell content, you use the ________ color list arrow.
  a. Cell
  b. Text
  c. Pattern
  d. Font

ANSWER: d

POINTS: 1

REFERENCES: SCEX 1-37

QUESTION TYPE: Multiple Choice
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HAS VARIABLES: False

LEARNING OBJECTIVES: 3.2.5 - Apply cell formatting.

CORPORATE STANDARDS: 837 - Change the font color of cell content.

TOPICS: Shelly Cashman Series: Formatting the Worksheet

KEYWORDS: Bloom's: Remember

DATE CREATED: 7/30/2019 4:07 AM

DATE MODIFIED: 7/30/2019 4:09 AM

50. A _______ refers to a collection of characters with a similar, specific design.
  a. symbol
  b. font
  c. point
  d. keyword

ANSWER: b

POINTS: 1

REFERENCES: SCEX 1-34

QUESTION TYPE: Multiple Choice

HAS VARIABLES: False

LEARNING OBJECTIVES: 3.2.5 - Apply cell formatting.

CORPORATE STANDARDS: 844 - Change the font of cell content.

TOPICS: Shelly Cashman Series: Formatting the Worksheet

KEYWORDS: Bloom's: Remember

DATE CREATED: 7/30/2019 4:09 AM

DATE MODIFIED: 7/30/2019 4:11 AM

51. The default worksheet text is _____-point Calibri.
  a. 10
  b. 11
  c. 12
  d. 14

ANSWER: b

POINTS: 1

REFERENCES: SCEX 1-36

QUESTION TYPE: Multiple Choice

HAS VARIABLES: False

LEARNING OBJECTIVES: 3.2.5 - Apply cell formatting.

CORPORATE STANDARDS: 850 - Change the font size of cell content.

TOPICS: Shelly Cashman Series: Formatting the Worksheet

KEYWORDS: Bloom's: Remember

DATE CREATED: 7/30/2019 4:11 AM

DATE MODIFIED: 7/30/2019 4:13 AM
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52. To return cell contents to its default font and style, you can use the _____ command.
  a. Clear Formats
  b. Clear Contents
  c. Clear All
  d. Clear Comments

ANSWER: a

POINTS: 1

REFERENCES: SCEX 1-59

QUESTION TYPE: Multiple Choice

HAS VARIABLES: False

LEARNING OBJECTIVES: 3.2.5 - Apply cell formatting.

CORPORATE STANDARDS: 1172 - Clear cell formatting.

TOPICS: Shelly Cashman Series: Correcting Errors

KEYWORDS: Bloom's: Remember

DATE CREATED: 7/30/2019 4:13 AM

DATE MODIFIED: 7/30/2019 4:15 AM

53. When you underline cell content, you are using _____.
  a. a font style
  b. an orientation setting
  c. an indent setting
  d. a centering style

ANSWER: a

POINTS: 1

REFERENCES: SCEX 1-32

QUESTION TYPE: Multiple Choice

HAS VARIABLES: False

LEARNING OBJECTIVES: 3.2.5 - Apply cell formatting.

CORPORATE STANDARDS: 4409 - Underline cell content.

TOPICS: Shelly Cashman Series: Formatting the Worksheet

KEYWORDS: Bloom's: Understand

DATE CREATED: 7/30/2019 4:15 AM

DATE MODIFIED: 7/30/2019 4:17 AM

54. To align currency symbols and decimal points in a column of numbers, you can apply the ____ number format.
  a. Currency
  b. Accounting
  c. Percentage
  d. General

ANSWER: b

POINTS: 1

REFERENCES: SCEX 1-41
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QUESTION TYPE: Multiple Choice

HAS VARIABLES: False

LEARNING OBJECTIVES: 3.2.4 - Apply number formats.

CORPORATE STANDARDS: 551 - Apply the Accounting number format.

TOPICS: Shelly Cashman Series: Formatting the Worksheet

KEYWORDS: Bloom's: Remember

DATE CREATED: 7/30/2019 4:17 AM

DATE MODIFIED: 7/30/2019 4:19 AM

55. To apply a cell style, you would use the Cell Styles command on the _____ tab.
  a. Layout
  b. Insert
  c. View
  d. Home

ANSWER: d

POINTS: 1

REFERENCES: SCEX 1-32

QUESTION TYPE: Multiple Choice

HAS VARIABLES: False

LEARNING OBJECTIVES: 3.2.7 - Copy, cut, and paste a table.

CORPORATE STANDARDS: 414 - Apply a cell style.

TOPICS: Shelly Cashman Series: Formatting the Worksheet

KEYWORDS: Bloom's: Remember

DATE CREATED: 7/30/2019 4:19 AM

DATE MODIFIED: 7/30/2019 4:22 AM

56. To combine multiple cells into one combined cell, which of the following do you use?
  a. Column Width command
  b. Center button
  c. Merge and Center button
  d. Increase Indent button

ANSWER: c

POINTS: 1

REFERENCES: SCEX 1-38

QUESTION TYPE: Multiple Choice

HAS VARIABLES: False

LEARNING OBJECTIVES: 3.2.1 - Check spelling.

CORPORATE STANDARDS: 2839 - Merge cells.

TOPICS: Shelly Cashman Series: Formatting the Worksheet

KEYWORDS: Bloom's: Remember

DATE CREATED: 7/30/2019 4:22 AM

DATE MODIFIED: 7/30/2019 4:25 AM
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57. Which of the following lets you apply bold formatting to a selected cell? Select all the options that apply.
  a. Home tab
  b. Format Cells dialog box
  c. Insert tab
  d. Mini toolbar

ANSWER: a, b, d

POINTS: 1

REFERENCES: SCEX 1-35

QUESTION TYPE: Multiple Response

HAS VARIABLES: False

LEARNING OBJECTIVES: 3.2.5 - Apply cell formatting.

CORPORATE STANDARDS: 622 - Bold cell content.

TOPICS: Shelly Cashman Series: Formatting the Worksheet

KEYWORDS: Bloom's: Remember

DATE CREATED: 7/30/2019 4:26 AM

DATE MODIFIED: 7/30/2019 4:30 AM


